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1 HOUSEKEEPING ITEMS 

 

1.1 Information Documents   
Each job may come with accompanying text documents such as time-stamped information from 

the stenographer or (digital) court recorder, an audio-recording worksheet with the case 

caption, appearances of counsel, dates, name spellings, addresses, and other pertinent 

information.  Please make sure to utilize these.   The time-stamped notes may have some minor 

spelling errors because these are taken live, concurrent with the proceeding.  Make sure you do 

your usual research.  If you cannot verify the spelling of a name but it's included in the reporter's 

notes, you may default to that spelling. 

1.2 Transcriber Worksheet 
For each transcript there will need to be a Transcriber Worksheet filled out. Name the 

worksheet as Worksheet<job#>.Transcript<transcript#>. 

 Please include only the following information on the sheet (see sample in Appendix): 

• Transcriber – Your name 

• Customer job No. – This is the number in the claims number column in the TMS 

• Allegis transcription No. 

• Case/Ref: Either the Case name or the witness’s name if there is not a court case associated 

with the transcript /Case number.  For example:   Party A v. Party B / Case No. 123456789 

• Inaudibles – the Page, Line and Time (with media letter/number if audio is split into multiple 

files) 

• [sic] -- the Page, Line and Time (with media letter/number if audio is split into multiple files) 

• You do not need to fill out the ALLEGIS BILLING information at the bottom of the worksheet.  

We will continue to send your weekly page report. 

2 TEMPLATES and DOCUMENT FORMATTING 

The templates for Examinations under Oath (EUOs), depositions, hearings and trials are 

preformatted per customer and Allegis's legal style.   

2.1 Lines 
Some templates have 22 lines per page and some have 25.  Make sure ALL the pages have the 

correct number of lines for the specific template you're using, including the Certificate of 

Transcriber and Reporter Certificate pages. 

2.2 Naming convention 
• Please name your transcript: Job <job#><initials of deponent if it is a multiple-interview 

job> .Transcript<transcript#> when you Save As. 
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• The job number will be in the claim number field in the TMS, if you're using Audioworxs as 

your player.  Example: 

Job123456.Transcript12345678 

Job123456PT.Transcript12345678 

 

2.3 Font 
The templates are in Courier New and all transcription should also be Courier New 13 point or 12 

point, depending on the customer.  Veritext templates are in 13 pt. and Verbatim are in 12 pt. 

2.4 Cover page 
• Cover pages for EUOs, Depositions, Hearings and Trials - Include deponent’s or witness’ 

name, claim or case number, date and time, location, and the reporter or recorder’s name 

(if applicable).  Note:  Not all reporters are court reporters.  Some are digital audio 

reporters.  If they speak, please use the same title for all of them:  COURT REPORTER. 

• The cover page information should match that of the Notice of Deposition/EUO/etc. or 

Reporter Worksheet if the Notice is not provided.  Please also match the style from the 

Notes, if provided.  Example: 

SUPERIOR COURT OF THE STATE OF CALIFORNIA 

FOR THE COUNTY OF SAN FRANCISCO 

2.5 Header 
• EUO – Witness name and date should be filled out for every transcript. 

Examination Under Oath, John Doe, 8/18/2018 

• Deposition and Hearings – Case name, type of proceeding, witness name and date should 

be filled out for every transcript. 

 
Batman v. Commissioner/Deposition of James Dean, 6/12/2018 
 

• The header information should match that of the Notice of Deposition/EUO/etc. or 

Reporter Worksheet if the Notice is not provided. 

 

2.5.1 Line Spacing 

The templates are set up with correct spacing.  Make sure you select the correct template by 

proceeding and customer. 
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2.5.2 Indentation settings 

• Q&A – at 0.5 

• Colloquy – at 1.0 (for Verbatim, 0.5) 

• Parentheticals – at 1.0 

The templates have preset formatting for each customer. 

2.5.3 Paragraphing 

Paragraphing is acceptable formatting legal transcripts.  Please see the Allegis Legal Manual 

section on Paragraphs for more in-depth information. 

2.5.4 Certificate of Transcriber page 

• Includes the date and transcriptionist’s signature.  This signature should be typed; it 

doesn’t need to be written and scanned into the document. 

• Include the Case name and the Case number. 

• DATE and Transcriber Name lines should look like this: 

 

6/20/2018    ______________________ 

     

DATE     JANE DOE 

 

2.5.5 Reporter Certificate page 
This page is part of the template and the reporter's name should be typed in the spaces 

provided.  If there is no reporter present, please remove this page. The highlighted message on 

the first line of this certificate page should be deleted if the page is used. Be sure to add returns 

at the bottom of the page so the page has the correct number of line numbers showing – 22 or 

25, depending on the template. 

2.5.6 Acknowledgement of Deponent page 
This page is part of the template and should be included ONLY IF the signature was reserved.  

That is, if the box for Read and Sign is checked Yes on the Audio Reporter Worksheet, or if you 

can hear the attorney and/or witness say they wish to read the transcript.  Fill in the witness's 

name and the name and address of the handling attorney.  The handling attorney is the 

witness's attorney.  The taking attorney is the main Q in the deposition or EUO. 

2.5.7 Appearance page 
Includes the names of the attorneys present.  If someone is present who is not listed in the 

information documents and no title for them is given, please list them last as  

Also appearing: 
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2.5.8 Contents page    

Includes the name of the witness, the name of the attorney, and on which page the following 
starts: 

Direct examination (DX):  Questioning of a witness by the party that has called the 
witness to give evidence. 

Cross examination (CX):  Questioning by the opposing counsel following the direct 
examination. 

Re-direct examination (RDX):  The rebuttal to the Cross Examination by the party that 
called the witness. 

Re-cross Examination (RCX):  The rebuttal to the Cross-Examination rebuttal, done by 
the opposing party. 

If any of the aforementioned examinations are not included in the EUO or deposition, please 
remove any number symbols and leave blank.   

 

2.5.9 Exhibits Page 
 

After the Contents page is the Exhibits page.  Number, describe and list the page the exhibit was 

marked and/or admitted. 

 

 



7 
 

2.5.10 Proceedings  

First page on which the proceeding starts.  This will always start on Line 1 of the page following 
the Contents page. The word PROCEEDINGS should be centered and in capital letters.  See 
example under Swearing in. 

2.5.11 Swearing in  

In depositions or EUOs the court reporter or audio reporter will swear in the witness or person 

being deposed. This is not transcribed verbatim (and you may barely hear the exchange 

between court reporter and witness as it will more than likely be faint); rather, please insert the 

following in the transcript:  ‘WHEREUPON,’ (in caps on the left margin followed on the next line 

by the witness’s name in all caps centered on the page and then on the following line on the left 

margin with ‘called as a witness, and having been sworn by the notary public, was examined 

and testified as follows:’  

  

2.5.12 Heading for questioning  

The beginning of questioning by an attorney should always be noted by the heading: DIRECT 
EXAMINATION, etc. centered on the page.  This is followed on the next line on the left margin by 
the word BY (attorney’s name).   

3 TRANSCRIPTION 

3.1 Verbatim 
Transcripts for EUOs and Depositions should be typed verbatim.  In the interest of readability, 

however, false starts, stutters and ums and uhs are not included unless they would alter the 

meaning of a statement.   

You may type Q: as clean verbatim as long as you limit this to a short repeat or nonverbal 

response (mm-hmm, uh-huh).  For example: 
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Spoken Can be typed 

 
Q      If there – if there was only one lane in 
the road. 

 
Q       If there was only one lane in the road. 

  
Q     How much pay would you have received 
from those two weeks in 2016? 

Q     How much pay would you have received 
from those two weeks in 2016? 

A     Well, this is approximate. A     Well, this is approximate.  No less than 
$2000. 

Q     Uh-huh.  
A     No less than $2000.  

 

Great effort should be given to keep sentences together whenever possible when two people 
are speaking.   

3.1.1 Informal contractions 

Informal contractions are not used in deposition transcripts.  Rather than using gonna, wanna, 

shoulda, ain’t, etc. please use the more formal going to, want to, should have and am not.  I’m, 

don’t, can’t etc. are not informal and are acceptable.  Please type would have, could have, etc. 

instead of would've, could've.  See p. 33 in the Allegis Legal Manual for further discussion. 

3.1.2 Inaudible words   

Although very rare, if a word or phrase is not understood, please use [inaudible]. All inaudible 

words and phrases will be listed on the Transcriber Worksheet by page number, line number 

and the time in the audio.  Any transcript containing [inaudible] must be sent to QA. 

3.1.3 Phonetic spelling  

Words spelled phonetically should be followed by [ph].  

3.1.4 Common Words  

Please use the following versions of these common words:   

Okay – not m’kay or OK. 

‘Cause –not ‘cuz for the abbreviated version of “because.” 

 All right – this is always two words. Never use “alright.” 

3.1.5 Numbers   

GENERAL RULE:  All numbers one through nine are spelled out.  Numbers 10 and over are in 
numerical form.  Do not start a sentence with a numeral.  (For detailed information and 
exception to these rules, please see the Allegis Legal Manual section on Numbers.) 
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• Dates are written using cardinal numbers rather than ordinals, if possible.  October 5, 
2017.   BUT:  October 5th. 

• Dates spoken as numbers only should be typed with slashes, not dots or periods:  
12/12/10 not 12-12-10 or 12.12.10. 

• Only use dollar sign if “dollars” is spoken.  Only use the percent sign if "percent" is 
spoken.  If you spell out the number, you must spell out "dollars" and "percent" as well. 

• Single and double quotation marks are not used to indicate feet and inches. 

• Time should be written out if spoken as “number o’clock.”  If it’s clear in context that 
people are speaking about time, then “eight fifteen” can by typed 8:15.  Otherwise, type 
as “eight fifteen.”   

• Do not use superscript for ordinals.  Example:  123 42nd street.  Go to File > Options > 
Proofing > AutoCorrect Options > AutoCorrect and uncheck the box for replace Ordinals 
(1st) with superscript. 

• All lab values and medication dosages under 1 take a leading zero. 

• Any unclear number(s) should be spelled out. 
 

 

 

Transcribed Spoken 

Q   How far away were you?  
A   About four to five feet “About four to five feet” 

A   About five to eleven feet “About five to eleven feet” 

 
Q  How much Xanax did you take? 
A 0.5 milligrams. 
 

"Point five milligrams" 
 

Q   How much did you pay for that?  
A   About four to five dollars. “About four to five dollars” 

A   About 10 to 11 dollars. “About ten to eleven dollars” 

A   About $5 "About five dollars" 

A   One hundred to one hundred-twenty 
dollars. 

“One hundred to one hundred- twenty 
dollars.” 

A   $120 "A hundred twenty dollars" 

  
Q   What time was it?  
A   8:15 (if it’s clearly time) "Eight fifteen"  

A   Eight o'clock "Eight o'clock" 

  
Q   When did that happen?  
A   Nine thirty If unclear whether time or date 

A  10 to 10 "Ten to ten" 
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3.1.6 Pauses  

Pauses should not be indicated in transcripts. 

3.1.7 Strike that 

The phrase “strike that” and all words before and after should be included in the transcript. 

3.1.8 Interruptions and trailed off testimony 

Interruptions should be indicated by a dash (using two hyphens) rather than an ellipsis.  The 

dash should also precede the continuation of a statement if indicated. Note:  Depending on your 

version of Word, you may need to change your settings so a double hyphen does not 

automatically turn into an em dash (a longer single line). 

MR. SMITH:    That’s why I -- 

Ellipses are to be used for trailing off only.  These are not often used in legal transcripts.  Make 

sure you have a space before the ellipses begin: 

MR. SMITH:    And that’s all I know about that, so … 

Note:  Please do not overuse dashes or ellipses. If it is possible to make a complete sentence, do 

so. 

3.1.9 Quotation Marks  

The standard double quotation mark is used for depositions and EUOs.  Please turn off smart 

quotes in Word.  Go to File > Options > Proofing > AutoCorrect Options > AutoCorrect and 

uncheck the box for replace straight quotes with smart quotes. 

3.1.10 Italics 
For any titles, case captions, etc. that are within the body of the transcript, please use italics 

and not underlining.   

Doe vs. District of Columbia, NOT Doe vs. District of Columbia 

3.1.11 Annotations 
• Annotations use brackets; parentheticals use parenthese. 

• [sounds like], [crosstalk], [RD] and [laughs] are not used in legal transcripts.   

• [sic] may be used only if the speaker makes a factual error that is not corrected later or 

questioned by an attorney.  Example: The witness say that they were CEO of SUPER 

Corporation in 1915 when the witness is clearly not over 100 years old, and no attorney 

questions or corrects this statement. If you use [sic], you must put it on the Transcriber 

Worksheet with a time stamp and route the job to QA. 

• [inaudible] is used if you are unsure of what you’re hearing.   

• [ph] If you really think you’re hearing correctly but you can’t document the term, you 

can use [ph] which stands for "phonetic."  Be very judicious with the [ph] annotation; it 
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is better to send an inaudible for QA to fill in than to have incorrect term in a transcript 

which goes directly to the customer. 

• [No audible response.] is used for answers that are given as gestures only, for example a 

nod of the head.  This would either be marked in the notes, or noted in the transcript 

itself ("Was that a yes?").  See Indiscernible Speech in the Manual for more examples. 

3.1.12 Capitalization 
The titles of all documents and notices should always be capitalized.  For example:  Notice of 

Deposition Duces Tecum. 

4 SPEAKER IDENTIFICATION 
There are a few major differences in the way the speakers are identified in an EUO or 

deposition as opposed to an informal recorded statement.  Allegis's legal style has NO 

colon after the speaker tokens Q and A. 

4.1.1 Colloquy  

During colloquy, the speakers should be identified using all caps using the honorific MR., MS. 

(MRS. is not used) or DR. along with the appropriate last name and then a colon.   Start typing 

two spaces to the right of the colon.  After the colloquy, identify Q again by name as shown 

below, aligned left. 

• By line:  Make sure to add the BY MR./MS. NAME:  statement each time Q speaks 

following colloquy no matter how brief the colloquy is (even if it is a single line). 

Example (Here Q is Ms. Jones and Mr. Smith is the witness’s attorney): 

Q Okay.  Can you describe the layout of the 

roadway? 

MR. SMITH:  Objection for form.  Go ahead and 

answer. 

MR./MS. WITNESS'S LAST NAME:  I would say it's 

flat. 

BY MS. JONES: 

Q Okay.  So you're familiar with the area where 

the accident occurred, correct? 

  A Yes. 
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• Exception:  In Hearings/trials, always use THE WITNESS to identify the deponent in 

colloquy rather than MR./MS. LAST NAME. 

4.1.2 Interpreter 
If an interpreter is present, the answers given should still be in Q and A format and use THE 

INTERPRETER for the interpreter only if they are speaking for themselves.  Please see the 

Interpreted Guidelines for a more extensive explanation. 

4.1.3 Court Reporter   

COURT REPORTER should be used for identifying the court reporter as well as the digital audio 

reporter. 

4.1.4 ATTY vs. Q  

ATTY is never used in legal transcripts. An examination by an attorney is always prefaced by the 

BY MR. or MS. identifier, and then followed in Q and A format.   

 

DIRECT EXAMINATION  

BY MR. JONES: 

 Q Good morning.  Thank you for appearing today. 

A Good morning. 

4.1.5 Judge 
In Hearings/trials, when the Judge speaks, she is always addressed in colloquy as THE COURT. 

4.1.6 Unidentified Speaker 
If there are unidentified speakers, use UNIDENTIFIED SPEAKER_#.  If there are multiple 

unidentified speakers, distinguish between them using numbers. 

5 PARENTHETICALS 
Parentheticals are used to record an action or event. Wording for parentheticals should be clear 

and concise.  Parentheses are always used for parentheticals, not brackets.  Brackets are used 

for annotations. 

5.1.1 Exhibits 

One of the most common uses of a parenthetical is the marking of an exhibit. When transcribing 

from an audio file only, we need to listen for the verbal clues that an exhibit has been marked.  

Generally, this will come from the court reporter, but this may also come from an attorney 

remarking that the exhibit was marked.    After this has been noted, the parenthetical 

(Whereupon, Deponent’s (or Petitioner’s, Plaintiff’s, Defendant’s) Exhibit 1 was marked for 

identification) should be typed on its own line.  
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MR. SMITH:  Let me show you what I'm going to have 

marked as Deponent's Exhibit No. 1.  Can you identify 

what the photograph shows? 

(Whereupon, the document referred to was marked 

for identification as Deponent's Exhibit 1.) 

  MR./MS. WITNESS'S NAME:   That's the back of the 

car. 

BY MR. SMITH: 

Sometimes, it might not be stated specifically that an Exhibit has been marked.  When an Exhibit 

is mentioned for the first time, it should be followed by the parenthetical to indicate its 

entrance in the record.  If it is clear that the Exhibit was already marked, do not include the 

parenthetical statement. 

If it does not say in the information documents or the audio whose exhibit it is, please simply 

use Exhibit # as the identifier:   

(Whereupon, Exhibit 1 was marked for identification.) 

If there is no information in the reporter's notes, and you cannot tell from context whether the 

exhibit is being marked, mark it anyway just to be safe. 

5.1.2 Off the record: 

When an attorney asks to go off the record, the parenthetical (Off the record) or (Discussion 

held off the record) should be inserted into the transcript.  Usually, when something is off the 

record, the recorder is turned off.  You would transcribe the parenthetical (Off the record) and 

nothing else until someone says “back on the record” or something similar.  

If for some reason the recorder is not turned off and they continue speaking, ending with “back 

on the record,” do not transcribe whatever is said off the record.   

If for some reason the recording does not include some version of “back on the record,” please 

do transcribe everything you hear.  We should assume in this case that what is recorded is all on 

the record. 

5.1.3 End/beginning of the media file: 
If the audio is in sections, the reporter may end/begin each section with a comment like this: 

COURT REPORTER: This marks the end of media number one.  

The time is now 2:37 p.m.  We are off the record. 

 (Off the record.) 
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 (End Media 1.) 

 (Begin Media 2.) 

COURT REPORTER:  This marks the beginning of media 

number two.  The time is now 3:00 p.m.  We are on the 

record. 

5.1.4 End of the deposition: 

The information of what time the deposition ends should be in the information sheet provided.  

Using that information, the parenthetical noting the end time of the deposition should be 

inserted. 

(Whereupon, at 12:10 p.m., the deposition of FIRST NAME 

INITIAL LAST NAME was concluded.) 

6 Interpreted Guidelines 
6.1.1 Appearances Page: 

Include the following information on the Appearances Page for the interpreter (if you have it): 

• Name 

• Agency 

• Phone number 

• Certification number 

6.1.2 Interpreter Oath: 
Use the following parenthetical for the swearing in of the interpreter: 

(Interpreter Name sworn to translate between English and (insert foreign language).) 

6.1.3 Basic Rules: 
• Because the interpreter speaks for the witness, all interpreted answers should be designated as A. 

• If the interpreter or attorney uses third person language, format as colloquy.  (See example 1 below.) 

• If the witness answers in English and the interpreter repeats this answer, simply type the 

interpreter's answer after the A speaker token.  Do not include the witness's English answer. 

• If the witness sometimes answers in English and this is not repeated by the interpreter, then include 

this parenthetical at the beginning of the transcript (see example 3 below): 

(All answers through interpreter unless otherwise 

noted.) 
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EXAMPLES: 

1. Interpreter and/or attorney beings to speak in the third person -> format as colloquy 

Deposition or EUO Hearing 

Q  And what is your address? 

A  1234 West Main Street. 

              MR. SMITH:   Ask him how old he is. 

              MR./MS. WITNESS'S LAST NAME:    I’m 

54.   

BY MR. SMITH: 

Q  How old did you say you are? 

              THE INTERPRETER:   He says he’s 54. 

BY MR. SMITH:  

Q Do you have any children? 

              THE INTERPRETER:   He said he has three. 

Q  And what is your address? 

A  1234 West Main Street. 

MR. SMITH:   Ask him how old he is. 

THE WITNESS:    I’m 54. 

BY MR. SMITH: 

Q  How old did you say you are? 

THE INTERPRETER:   He says he’s 54. 

BY MR. SMITH:  

Q Do you have any children? 

THE INTERPRETER:   He said he has three. 

 

 

2. Interpreter asks for clarification or additional information -> format as colloquy 

Q What is your current address? 

THE INTERPRETER:  Excuse me, Counsel, what was the 

question? 

BY MR. SMITH: 

Q What is your current address? 

A 1234 West Main Street. 

3. Witness answers sometimes in English and other times in a foreign language -> indicate when 

answering in English and add parenthetical at the beginning of testimony following the swearing 

in of the interpreter:  {All answers through interpreter unless otherwise noted.) 

Q How many children do you have? 
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A (In English) Three. 

4. Interpreter speaks for witness while in colloquy: 

Deposition or EUO INTERPRETER (FOR MR./MS. WITNESS'S LAST NAME): 

Hearing or trial INTERPRETER (FOR THE WITNESS) 

5. If a lengthy stand-alone phrase is used in answer to a question and it is not interpreted, include 

a parenthetical: 

A (Speaking in a foreign language.) 

6. When there is an issue with the interpretation, I.e. after a lengthy exchange between the 

interpreter and the witness after which the interpreter simply answers "yes," or the interpreter 

and witness are speaking without interpretation, do not transcribe and no parenthetical is 

needed.  It is the responsibility of the attorney to clarify the record. 

7. If a foreign word or short phrase, I.e., c'est la vie, gracias, merci, is used with no interpretation, 

it is acceptable to transcribe it as spoken.  Make sure to check audio reporter notes for any 

spellings. 

Please check the Allegis Legal Manual for extensive discussion of transcribing interpreted files 
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SAMPLE – EUO COVER PAGE 

 

EXAMINATION UNDER OATH 

OF 

FIRST MIDDLE LAST 

Case No.: 

 ######### 

 

 

DATE:  Day, Month, Year 

TIME:  ##:## p.m./a.m. 

LOCATION:  Street Address 

   City, ST, ZIP 

REPORTED BY: First Last 
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SAMPLE – DEPOSITION COVER PAGE 

S T A T E:  The state the court is in.  If the state name is included in the title below, delete this line 

IN THE CIRCUIT/DISTRICT COURT OF NAMED COUNTY 

Copy this information exactly from the Notice of Deposition, EUO, etc. or Reporter Worksheet 

-------------------------------- : 

FIRST LAST,     : 

Plaintiff,   : might be Claimant, Employer, etc, 

v.      : Case No.  

DEFENDANT NAME    : ##-XX-#####-XXX 

Defendant(s).   : 

----------------------- --------- : 

 

DEPOSITION OF FIRST MIDDLE LAST 

 

DATE:  Tuesday, September 4, 2018 

TIME:  12:21 p.m. 

LOCATION:  Name  

   Street Number 

   City, ST 

REPORTED BY: Reporter Name, Notary Public 
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P R O C E E D I N G S 

WHEREUPON, 

JOHN ADAMS DOE 

called as a witness, and having been sworn by the notary 

public, was examined and testified as follows: 

 

DIRECT EXAMINATION  

BY MR. SMITH:   

 Q All right.  Good morning, Mr. Doe.  Thank you for 

coming by this morning. 

 Could you just please state your business address and 

your full name for the record? 

 A John Doe.  My business address is 1234 Main Street 

Northeast, Washington, D.C. 20018. 

 Q Thank you.  And who is your employer? 

 A Acme Business Solutions. 

MR. SMITH:  Let’s go off the record for a minute. 

  (Off the record.) 

BY MR. SMITH:   

 Q I'm going to -- just for the purposes of 

questioning you, I'm going to go ahead and give you -- this 
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is printed directly from the database.  And so, in other 

words, you can see there that that's the back of an 

ambulance.  Here is -- do you see the motorcycle that's 

there? 

 A Yes, I do. 

Q Okay.  I want to go ahead, and I'll mark this. 

  MR. SMITH:  Can you please mark this as Deponent's 

Exhibit 1? 

(Whereupon, Deponent’s Name Exhibit 1 was marked 

for identification.) 

 Q I'll go ahead and -- while he's doing that.  You 

have a -- do you have a copy of the --  

 A Mm-hmm.  Yes. 

 Q Okay.  That is all.  

 

(Whereupon, at 10:11 a.m., the deposition of JOHN DOE was 

concluded.) 

 


